Chapter 18

Working with the
FreeStyle Workbench

Learning Objectives

After completing this chapter, you will be able to:
* Understand the FreeStyle workbench of CATIA V5

* Create surfaces in the FreeStyle workbench

* Modify surfaces in the FreeStyle workbench

* Use control points for deformations

* Use advanced operations on surfaces
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THE FREESTYLE WORKBENCH

As we know, most of the times, the shape of a product is designed using the surface modeling
techniques. Surface models are three-dimensional models with no thickness and mass properties.
CATTIA V5 provides a number of surface modeling tools to create complex three-dimensional
surface models. Various workbenches in CATIA V5 with surface creation tools are:

1. Wireframe and Surface Design
2. Generative Shape Design
3. FreeStyle

In this chapter, you will learn about the surface modeling tools in the FreeStyle workbench.
The tools available in the FreeStyle workbench are used to manipulate and refine the surface
created in this workbench. Moreover, you can create independent free form surfaces by using
the tools available in this workbench. The workbench also provide tools to analyze the surfaces.
You can use these tools of the FreeStyle workbench in the Part mode as well as the Shape mode.

STARTING A NEW FREESTYLE FILE

When you start CATIA V5-6R2022, a new Product file with lew Part X
the name Productl is displayed on the screen. Close this Enter part name
file by choosing the Close option from the File menu. To & Enable hybrid design

invoke the FreeStyle workbench, choose the FreeStyle [ Create a geometrical set
option from the Shape flyout in the Start menu; the New [ Creste an ordered geometrical set

Part dialog box will be displayed, as shown in Figure 18-1.
Enter the desired name in the Enter part name edit box
available in this dialog box and then choose the OK button;
the file with specified name will be created and the user [ EE P

[ Do not show this dialog at startup

interface will be displayed, as shown in Figure 18-2. Figure 18-1 The New Part dialog box
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Figure 18-2 CATIA V5-6R2022 with FreeStyle workbench invoked
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Alternatively, choose New from the File menu; the New dialog box will be displayed. Select
Shape from the List of Types list box in the New dialog box or write the word Shape in the
Selection edit box at the bottom of the List of Types list box. Next, choose the OK button; the
Shape name dialog box will be displayed, as shown in Figure 18-3. Enter the file name in it
and choose the OK button; a new file in the Shape workbench will be displayed on the screen.

Enter shape name | Shapel
@0k | @ cancel |

-
Figure 18-3 The Shape name dialog box

SETTING THE FREESTYLE WORKBENCH

After invoking the FreeStyle workbench, parameters such as tolerance, minimum deviation,
tuning, and so on need to be set. To do so, invoke the Options dialog box by choosing Options
from the Tools menu. Next, expand the Shape node by clicking on the + sign on the left of the
node in the dialog box. Choose FreeStyle from the expanded node; the tabs corresponding to
this selection appear on the right in the Options dialog box. Next, choose the General tab, if
it is not selected by default. The Options dialog box after choosing the General tab is shown
in Figure 18-4.
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Figure 18-4 The Options dialog box with the General tab chosen
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Set the values for tolerances, tuning, display settings, and so on by using the options available
in this tab.

You can change the color of various entities available in the FreeStyle environment by using
the options available in the Manipulators tab. The Options dialog box after choosing the
Manipulators tab is shown in Figure 18-5. After setting the required values, choose the OK
button from the Options dialog box.
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Translator properties
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Figure 18-5 The Options dialog box with the Manipulators tab chosen
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CREATING SURFACES

The tools available in the Surface Creation toolbar are used to create various types of surfaces,
refer to Figure 18-6. These tools are discussed next.

RLERD VO EL
Patches sub-toolbar | I;Slyling Sweep
Extrude Surface Net Surface
Revolve Fills Sub-toolbar
Offset Styling Fillet

Styling Extrapolate FreeStyle Blend Surface
Figure 18-6 The Surface Creation toolbar
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Patches Sub-toolbar

The Patches sub-toolbar is used to create patches using various tools available in this sub-toolbar,
The tools available in this sub-toolbar are discussed next.

Unified Patch

This tool is used to create various planar patches. To do so, choose .
this tool from the Patches sub-toolbar; the Unifies Patch dialog box

will be displayed, as shown in Figure 18-7. Various options available ’Pz;c“”pe

in this dialog box are discussed next. = gl El

- Reference Support

2-Point Patch o i

| 2~ This option is used to create planar patches by using two _
X points. To create a planar patch, choose the 2-Point Patch | [ =P
button from the Patch Type area of this dialog box; you will be
prompted to specify the start point of the planar patch. Click to
specify the start point of the patch, refer to Figure 18-8; you will
be prompted to specify the Second point of the planar patch, refer ‘°_| 3 Concel|

to Flgure 18-9. Chc.k at a desired location in the drgwmg area to Figure 18-7 The Unified
specify the end point of the patch or specify the dimensions of Potch sub-toolb

the patch. To specify the dimensions of the patch, right-click in arel suo-tootbar
the drawing area; a shortcut menu will be displayed, as shown in Figure 18-10. Choose the
Edit Dimensions option from the shortcut menu; the Dimensions dialog box will be
displayed, as shown in Figure 18-11. Now, specify the value of dimensions in the edit boxes
available in this dialog box. If you want to change the order of the surface patch (U and V
values), choose the Edit Orders option from the shortcut menu; the Orders dialog box will
be displayed, refer to Figure 18-12. Set the value of order in the U and V spinners. If you
hold the CTRL key while selecting the end point in the drawing area, the planar patch will
be created symmetric about the starting point.

@ Planar Direction
| | © Project on Plane
| | © Project and Fit to Support

Figure 18-8 The start point specified on the surface
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| 2=140.479mrm

L1=16E.257mm

Figure 18-9 The end point specified on the surface

Dimensions x
L1 | 167408mm E
L2 [230568mm =]

Edit Orders

& Cancel I

Figure 18-10 The shortcut  Figure 18-11 The Dimensions Figure 18-12 The
menu displayed dialog box Orders dialog box

Edit Dimensions

3-Point Patch

This option is used to create surface patches by
=% using three points. To create a 3-point patch,
choose the 3-Point Patch button from the Patch Type
area of this dialog box; you will be prompted to specify
the first point for the patch. Click to specify the first
point, refer to Figure 18-13. Now, move the cursor; a
rubber band line will be displayed and you will be
prompted to specify the second point for the surface
patch. Click in the drawing area to specify the second
point, you will be prompted to specify the third point
to complete the creation of the patch. Click in the
drawing area again at the desired position to specify
the third point; the patch will be created. If you hold
the CTRL key while specifying the third point, the patch will be created symmetric to the
line joining the first and second points. Figure 18-14 shows the preview of the patch to be
created on specifying the third point.

Figure 18-13 First point to be specified
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L1=265.11%9mrmn

L2=665.202mm

Figure 18-14 The preview of the patch to be created

4-Point Patch

This option is used to create surface patches by using four points. To create a 4-point
20 patch, choose the 4-Point Patch option from the Patch Type area of this dialog box;
you will be prompted to specify the first point of a patch on a surface or a datum plane.
Click to specify the start point; you will be prompted to specify the second point of the
patch. Specify the second point by clicking at the desired location on the surface or plane;
you will be prompted to specify the third point. Specify the third point on a plane or a
surface; you will be prompted to specify the fourth point. Click in the drawing area to specify
the fourth point; the patch will be created by using the four specified points as corner points.

Geometry Extraction

This tool is used to create surface patches on an already created surface. To do so, choose
% the Geometry Extraction tool from the Patches sub-toolbar; you will be prompted to select
a surface or a curve. Select an already created surface; you will be prompted to specify the start
point for the surface patch. Select a point on the surface; you will be prompted to specify the
end point of the patch surface, refer to Figure 18-15. Click on the surface to specify the end
point; the surface patch will be created.

Figure 18-15 Creating surface patch on a surface



18-8 CATIA V5-6R2022 for Designers

Extrude Surface

This tool is available in the Surface Creation toolbar. Using this tool, : . ‘
you can create a surface by extruding a curve or curves in vertical | -selection
or horizontal direction. To do so, choose the Extrude Surface tool Elements &
from the Surface Creation toolbar; the Extrude Surface dialog box | piection - tength

will be displayed, as shown in Figure 18-16, and you will be prompted I% [1omm ]
to select a curve. Select a curve from the drawing area; a surface of : e
the length specified in the Length edit box will be created. Specify 3' %I
the desired value of length in this edit box. To change the direction
of extrusion, you can choose the desired button from the Direction oo | @ cancel |

area of this dialog box. —
Figure 18-16 The Extrude

Surface dialog box

Revolve
Using this tool, you can create a surface by revolving a curve or curves around an axis. To
do so, choose the Revolve tool from the Surface Creation toolbar; the Revolution Surface

Definition dialog box will be displayed and you will be prompted to select a profile. Select the
curve(s) you want to use as a profile for the revolved surface; you will be prompted to specify
the axis of revolution. Select a curve or axis from the drawing area; a revolved surface will be
created. Figure 18-17 shows preview of the revolved surface along with the corresponding values
in the Revolution Surface Definition dialog box. Using the Angle 1 and Angle 2 edit boxes,
you can specify the value of revolution angle.

- on Surfa %
Profile: Mo selection
- Angular Limits
Limit 1
Type: | Dimensicn v|
Angle1:|130d59 E
Limit 2
Type: | Dimensicn v|
Angle 2: IOdEQ
@ Of I aCanceIl Previe I
.

Figure 18-17 A revolved surface along with the Revolution Surface Definition dialog box

Offset

‘ Using this tool, you can create an offset surface at a specified distance from the selected
=% surface. To do so, choose the Offset tool from the Surface Creation toolbar; the Offset

Surface dialog box will be displayed, as shown in Figure 18-18, and you will be prompted
to select a mono-cell surface. Select a surface from the drawing area; an offset surface will be
created. You can change the distance between the native surface and the offset surface by using
the dynamic edit box displayed on the surface. Alternatively, use the drag handles displayed on
the surface to change the distance. By default, the Simple radio button is selected so the offset
surface is created at a constant distance from the native surface. You can specify a different
offset distance at each corner point by selecting the Variable radio button from the Type area
of the Offset Surface dialog box. Figure 18-19 shows an offset surface created by using the
Variable radio button from the Type area.
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r Type
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) Order Delta U
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w 0K ] More... I GCanceI]

Figure 18-18 The Offset Surface dialog box

Corner points at
non-uniform
distances

Corner points at
non-uniform
distances

Figure 18-19 An offset surface created afler selecting the Variable radio button

Styling Extrapolate

Using this tool, you can create surface by extrapolating
“% an edge or a curve. To do so, choose the Styling
Extrapolate tool from the Surface Creation toolbar; the
Extrapolation dialog box will be displayed and you will be
prompted to select a curve or the boundary of a surface.
On doing so, the preview of the surface will be displayed,
refer to Figure 18-20. Also, the Extrapolation dialog box
will be displayed, as shown in Figure 18-21.

By default, the Tangential radio button is selected in
the Type area of the dialog box. As a result, the surface
created is tangential to the selected curve. If you select the
Curvature radio button from the Type area, the surface
created will follow the curvature of the selected curve. You
can also change the extent of surface by using the options
available in the Limit Type drop-down list.

Figure 18-20 Preview of the surface
created by using the Styling Extrapolate
tool
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X

Element: Mo selection

Length: Omm

Type O Exact
@ Tangential

) Curvature

- l < Cancell

-
Figure 18-21 The Extrapolation
dialog box

FreeStyle Blend Surface

== Usingthis tool, you can create a blend surface between two surfaces.

_ P
"To create this type of surface, choose the FreeStyle Blend Surface

tool from the Surface Creation toolbar; the Blend Surface dialog box Blend Type

will be displayed, as shown in Figure 18-22, and you will be prompted

to select a curve or an isoparameter. Select a curve or an isoparameter [

of a surface; you will be again prompted to select a curve or an L

. . Number of patches: -

isoparameter. Select a curve or an isoparameter of another surface; a OrderU/V: -

blend surface will be created. You can dynamically change the shape ey

of blending surface by moving the end points of the surface. Figure ) i s
18-23 shows two surfaces for blending and Figure 18-24 shows the

surfaces after blending. < | 8 cancel|

Figure 18-22 The Blend
Surface dialog box

Figure 18-23 Surfaces for blending
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Figure 18-24 Surfaces after blending

Styling Fillet

Using this tool, you can create fillets on the sharp edges of surfaces. To create a styling

fillet, choose the Styling Fillet tool from the Surface Creation toolbar; the Styling Fillet
dialog box will be displayed, as shown in Figure 18-25, and you will be prompted to select the
first support to create a fillet. Select the first support; you will be prompted to select the second
support for the fillet. Select the second support, refer to Figure 18-26, and then choose the
Apply button from the dialog box; a fillet will be created between the selected set of surfaces,
as shown in Figure 18-27. You can choose the Trim Support 1 and Trim Support 2 buttons from
the Styling Fillet dialog box to trim the extended surfaces in the fillet zone.
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Figure 18-25 The Styling Fillet dialog box
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Support 2

Support 1

Figure 18-26 Supports for the styling fillet Figure 18-27 Resultant styling fillet

Fills Sub-toolbar

The tools available in this sub-toolbar are used to fill the empty space created by three or more
contiguous surfaces, refer to Figure 18-28. The tools available in this sub-toolbar are discussed
next.

Fills

LB
Figure 18-28 The Fills sub-toolbar
Fill

This tool is used to create a fill surface. To do so, choose the Fill tool from the Fills
=% sub-toolbar; the Fill dialog box will be displayed, as shown in Figure 18-29, and you will
be prompted to select the contiguous edges. Select two or more contiguous edges, refer to
Figure 18-30, and then choose the Apply button from the dialog box; a fill surface will be created
and the continuity callouts will be displayed attached to the edges, as shown in Figure 18-31. By
using these continuity callouts, you can specify the point and tangent continuity between the
surrounded edges and filling surface. To specify the continuity, click on the continuity pop-up
once to invoke the contextual menu and then select the required type of continuity from it. After
specifying the continuity between the surrounding edges and the filling surface, choose the OK
button from the dialog box.

Fill ? x|
‘ Deformation direction : yl @‘
@ OFK I < Appl I & Cancel I

-
Figure 18-29 The Fill dialog box

Similarly, you can create a freestyle fill surface by using the FreeStyle Fill tool available in the
same sub-toolbar. Freestyle fill surfaces are associative to the selected surfaces.
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ANCHETI

Figure 18-30 Edges to be selected for ~ Figure 18-31 The fill surface created
Sull surface

Net Surface

This tool is available in the Surface Creation toolbar. Using this tool, you can create a

surface of specified profile following the path given by a guide curve. To create a net surface,
choose the Net Surface tool from the Surface Creation toolbar; the Net Surface dialog box will
be displayed, as shown in Figure 18-32. Also, you will be prompted to select a guide curve and
the guides(0) option will be highlighted in the preview area of the dialog box. Select a curve or
curves by holding the CTRL key. Now, select the profiles(0) option from the preview area and
select curves to be used as profile from the drawing area; the OK and Apply buttons will get
activated in the dialog box. Choose the OK button to create the net surface and exit the tool.
Figure 18-33 shows the curves required to create a net surface and Figure 18-34 shows a net
surface created by using the curves.

@ l <@ l & Cancel I

Figure 18-32 The Net Surface dialog box

Guide curves
Profile curves

Figure 18-33 The profile and guide Figure 18-34 The resultant net surface
curves for net surface
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Styling Sweep

5, This tool is available in the Surface Creation toolbar. |

Using this tool, you can create a styling sweep surface.

To do so, choose the Styling Sweep tool; the Styling Sweep
dialog box will be displayed, as shown in Figure 18-35. By |$
default, the profile option is selected in the Preview area and @
you are prompted to select a curve to specify a profile for the ﬂ
swept surface. Select a profile and then choose the spine @
option from the Preview area of the dialog box; you will be
prompted to specify a curve for spine. Select a curve for spine; 3
the OK and Apply buttons will get activated. Choose the &
Apply button to check the preview of the surface and then Figure 18-35 The Styling Sweep
choose the OK button to create the styling sweep surface. dialog box
There are four buttons available on the left of the dialog box
to create styling sweep surface using various parameters.

l < l & Cancel l

MODIFYING SURFACES

The tools available in the FreeStyle workbench are used to modify a surface. The tools required
to modify a surface are available in the Shape Modification toolbar, refer to Figure 18-36. Various
tools available in this toolbar are discussed next.

i) 88 & 5D
SymmetryJ J L I—Extend
Control Points Global Deformation
Match Surface Fit to Geometry

Figure 18-36 The Shape Modification toolbar

Symmetry
This tool is used to create a copy of the selected surface
or a shape which is symmetric about a specified

reference. To create a symmetric copy of an element, choose | Elemens &
the Symmetry tool from the Shape Modification toolbar; | geterence: [No selection |
the Symmetry Definition dialog box will be displayed, as Hide/Show initial element |
shown in Figure 18-37, and you will be prompted to select | gy @ O

the element to be transformed. Select the element to be
transformed; you will be prompted to specify a reference |y
point, a line or a plane. Select a reference element; preview
of the symmetric element will be displayed in the drawing
area, as shown in Figure 18-38. Choose the OK button to
create the symmetric element and exit the tool.

] I & Cancel I I |

Figure 18-37 The Symmetry
Definition dialog box
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Symmetric

element
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Figure 18-38 Preview of the symmetric element

Control Points

This tool is used to modify an element by using the

control points on the surface. To modify an element,
choose the Control Points tool from the Shape Modification
toolbar; the Control Points dialog box will be displayed, as
shown in Figure 18-39, and you will be prompted to select a
surface or a curve for modifications. Select a surface from the
drawing area; control points will be displayed on the surface,
refer to Figure 18-40. You can increase the controlling curves
by clicking on the Nu:XX callout. Using the control points
displayed on the surface, you can dynamically modify a
surface. After modifying the surface, choose the OK button
to accept the changes.

The buttons available in the Control Points dialog box are
discussed next.

Support Area
There are six options available in this area: Normal to
compass, Mesh Lines, Local Normals, Compass plane, Local

next.

Normal to Compass

Elements: Mo selection @

Support

[ 8| 3 & A 4

Filters Selection

= o )] e o

Global Diffusion Cross Diff
BE 1Bl |- Bl
Symmetry Projection

7, 8| &

Harmonization Options

ﬁ Blend - % A“{}ﬂ

Smooth
u 0.50
& M—

Deviation : -

Element: 0- Selected: --/--

Support : Normal Z

_— @ 0K I ﬂ(‘ancell

Tangents, and Screen Plane. These options are discussed Figure 18-39 The Control Points
dialog box

ﬂ The Normal to compass button is used to modify a surface in a direction perpendicular

to the compass.

Mesh Lines

@ The Mesh Lines button is used to modify a surface along the mesh lines.

Local Normals

% The Local Normals button is used to modify a surface along the normal vector on

each grid line.

Compass plane

@ The Compass Plane button is used to modify a surface along the compass plane in

the X and Y directions of the compass plane.
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Local Tangents

The Local Tangents button is used to modify a surface along and normal to the local
ﬂ tangents.

Screen Plane
ﬂ The Screen Plane button is used to modify a surface along the screen plane.

Figure 18-40 The surface with control points

Filters Area

The options in this area are used to filter entities during selection. There are three options
available in this area and are discussed next

Points only

o

.*.| Choose this button if you need to select only points on the surface for modification.

ChElc

Mesh only
m Choose this button if you need to select only mesh on the surface for modification.

Points and mesh

Choose this button if you need to select points as well as mesh on the surface for
modification.

Selection Area

The buttons in this area are used to select or deselect points available on the surface and are
discussed next.

Select all points

£+| Choose this button if you need to select all the points available on the surface.

Deselect all points
J Choose this button if you need to deselect all the points selected on the surface.
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Global Area
There is only one button available in this area. This option is used to modify a surface in the
global mesh mode.

Diffusion Area
The buttons in this area are used to specify the pattern to be followed while moditying a surface.

Cross Diff Area
The buttons available in this area are used to specify the laws to be applied on the points and
mesh, which are not directly manipulated while modifying the surface.

Symmetry Area
The buttons available in this area are used to make a surface symmetric about a reference plane.

Projection Area

There are two buttons available in this area: Project along the compass normal and Project
in the compass plane. The Project along the compass normal button is used to project the
modified surface along the direction normal to the compass plane. The Project in the compass
plane button is used to project the modified surface in the compass plane.

Harmonization Area
The buttons in this area are used to harmonize control points and mesh lines of the surface.

Options Area
The buttons in this area are used to display or hide the inflections, deviations, and harmonization
planes.

Smooth Area
The buttons in this area are used to smoothen the transition of control points and mesh of the
surface while modifying it up to a desired level.

Match
The Match sub-toolbar, refer to Figure 18-41, is available in the Shape Modification toolbar.
There are two tools available in this sub-toolbar which are discussed next.

£ 1
Figure 18-41 The Match sub-toolbar

Match Surface
2 This tool is used to match two surfaces or a surface and a curve. To do so, choose the Match
Surface tool from the Match sub-toolbar; the Match Surface dialog box will be displayed,
as shown in Figure 18-42, and you will be prompted to select a boundary to be matched with a
curve. Select the boundary of the surface; you will be prompted to select the target curve for the
boundary. Select an edge of another surface; the match surface will be created. Figure 18-43
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shows two surfaces before applying the Match Surface tool and Figure 18-44 shows the surfaces
after applying the Match Surface tool.

Match Surface ? *

rlype————
puto o] Merez2
~ Information

Mumber of patch(es): -  Order: -
Type: - Delta: -

- Options

[ Project end points
[ Project boundary
[ Move on main axis

[ Diffusion

w OK I OCancell
-

Figure 18-42 The Match Surface dialog box

Y -

Figure 18-43 The surfaces before applying the
Match Surface tool

Figure 18-44 The surfaces after applying the
Match Surface tool

Multi-Side Match Surface

This tool is used to match a surface with two or more surfaces. To create a multi-side match
S22 surface, choose the Multi-Side Match Surface tool from the Match sub-toolbar; the

Multi-side Match dialog box will be displayed, as shown in Figure 18-45, and you will be
prompted to select an edge.

Multi-side Match ? * |

Opticns

[ Diffuse deformation

[ Optimize continuities

| @ 0K I @ Appl) I OCanceIl_I

Figure 18-45 The Multi-side Match dialog box

Select the desired option from the dialog box and then select the edges to be matched one by
one. Next, choose the OK button to create a multi-side match surface.
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Fit to Geometry
o This tool is used to change the shape of a surface by fitting it over the control points. To
do so, choose the Fit to Geometry tool from the Shape Modification toolbar; the Fit to
Geometry dialog box will be displayed, as shown in Figure 18-46, and you will be prompted to
select a surface to be fitted. Select the Sources radio button from the Selection area of the dialog
box and then select the source surface from the drawing area. Next, select the Targets radio
button from the dialog box and then select the target surface from the drawing area. Next,
choose the Fit button from the dialog box to display the preview of surface. Choose the OK
button to create the surface.

Selection Fitting
@ Sources (0) e, 0.00
O Targets (0) 0‘_00

J'—

Projection

[ Automatic trap
[ Impose direction

. l l & Cancel l

-
Figure 18-46 The Fit To Geometry dialog box

Global Deformation
A This tool is used to deform a surface globally. To do so, choose the Global Deformation
2. tool from the Shape Modification toolbar; the Global Deformation dialog box will be
displayed, as shown in Figure 18-47, and you will be prompted to select a surface. Choose the
desired options from the Type area and the Guides area, and then select the surface; the Run
button will be activated in the dialog box. Choose the Run button; the surface with the control
points and mesh will be displayed. Change the shape of the surface by using these points and
mesh, and then choose the OK button from the Control Points dialog box to accept the changes.

Type Guides

| Cr—
[m]

l & Cancel l

.
Figure 18-47 The Global Deformation dialog box

Extend

B This tool is used to extend a surface by using the control points

displayed on the surface. To do so, choose the Extend tool from the
Shape Modification toolbar; the Extend dialog box will be displayed, as | [Mede _
shown in Figure 18-48, and you will be prompted to select a surface. Select | | = <P seamenttion
the surface; control points will be displayed on the surface. Using these 2 0¢ | @ cancal|
control points, you can deform the surface. After deformation, choose the

OK button to accept the deformation and exit the tool. Figure 18-48 The
Extend dialog box
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You can make further changes in the surfaces to get the final shape by using the tools available
in the Operations toolbar, refer to Figure 18-49. These tools are discussed next.

Operations .
. L o
S WE e
I T
Break Surface J I_ Copy Geometric
or Curve Farameters
L— Converter Wizard

Untrim Surface __|
or Curve

——Disassemble

Concatenate ——

Fragmentation

Figure 18-49 The Operations toolbar
Break Surface or Curve

This tool is used to break a surface or a curve at a specified reference. To break a surface

or a curve, choose the Break Surface or Curve tool from the Operations toolbar; the
Break dialog box will be displayed, as shown in Figure 18-50, and you will be prompted to select
a cutting element. Choose the Break Surfaces option from the Break Type area of the Break
dialog box and then select the cutting surface from the drawing area; a red dot will be attached
to the cursor. Click on the desired location on the surface; a manipulation handle will be displayed
on that location, refer to Figure 18-51. Using this manipulation handle, you can change the
position of the trimming line. Now, choose the Apply button to display the preview of trimming,
refer to Figure 18-52. Next, choose the OK button from the dialog box to accept the preview.
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e (TN ] ]2
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Trim Type Projecticn
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Figure 18-50 The Break dialog box

Untrim Surface or Curve

& This tool is used to recreate the surface or the curve trimmed by the Break Surface or

Curve tool. To do so, choose the Untrim Surface or Curve tool from the Operations
toolbar; the Untrim dialog box will be displayed and you will be prompted to select elements
to be untrimmed. Select the trimmed surface from the drawing area and choose the OK button
from the Untrim dialog box; the trimmed surface will be untrimmed.
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Side to be
removed

Manipulation Handle

Figure 18-51 The surface to be Figure 18-52 Preview of the surface
trimmed with manipulation handle afier trimming
Concatenate

This tool is used to convert the contiguous curves into a mono-cell curve. To do so, choose
the Concatenate tool from the Operations toolbar; the Concatenate dialog box will be
displayed and you will be prompted to select the contiguous curves to be concatenated. Select
the curves and then set the desired value of tolerance in the spinner available in the Concatenate
dialog box. Now, choose the Apply button to display the preview of concatenated curve. Now,
choose the OK button to accept the preview and exit the tool.

oo
am

Fragmentation
" This tool is used to convert a mono-cell curve into multiple contiguous curves. To do so,
“ choose the Fragmentation tool from the Operations toolbar; the Fragmentation dialog
box will be displayed and you will be prompted to select a mono-cell curve. Select the mono-cell
curve and choose the OK button to create contiguous curves.

Disassemble
8 This tool is used to create multiple mono-cell objects from the multi-cell objects. To do so,
choose the Disassemble tool from the Operations toolbar; the Disassemble dialog box
will be displayed and you will be prompted to select multi-cell objects. Select a multi-cell object
and then choose the OK button from the dialog box to create multiple mono-cell objects.

Converter Wizard

This tool is used to change the tolerance, order, and

segments of a curve. 'To do so, choose the Converter -
Wizard tool from the Operations toolbar; the Converter A Tokrncs
Wizard dialog box will be displayed, as shown in & Orders
Figure 18-53, and you will be prompted to select a curve. O Along U Aleng V

Select the curve and choose the desired toggle button |, |- segmentation

from the left in the dialog box to apply the transformation. | O

The options corresponding to the selected toggle button Along U1 T Along V[T

will be activated in the dialog box. You can change the Mo |

values as required and then choose the Apply button to |S

display the preview. Now, choose the OK button to accept soc ] 3 | 8 concel

.
Figure 18-53 The Converter Wizard
dialog box

the preview.
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Copy Geometric Parameters

a This tool is used to copy the parameter of a selected
*== curve on the target curve. To do so, choose the Copy
Geometric Parameters tool from the Operations toolbar;
the Copy Geometric Parameters dialog box will be
displayed, as shown in Figure 18-54, and you will be
prompted to select a reference curve. Select the reference
curve; you will be prompted to select a target curve. Select
the target curve and choose the OK button from the dialog
box; the parameters of the selected curve will be copied on
the target curve. Note that the target curve should be a datum
curve made of only one edge and should have same limit as
the curve.

TUTORIALS

Tutorial 1

J o J - CanceIJ

Figure 18-54 The Copy Geometric
Parameters dialog box

In this tutorial, you will create the model of a car bonnet, as shown in Figure 18-55.

(Expected time: 45 min)

Figure 18-55 Final model of the car bonnet

The following steps are required to complete this tutorial:

Create a curve at the center of the surface.
Change the number of control points.

opo o

Deform the surface by using control points.

Start a new file in the FreeStyle workbench and create a planar surface.

Create a datum plane for making the deformation symmetric about centerline.
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Starting a New File in the FreeStyle Workbench

You need to start a new file in the FreeStyle workbench. To start a new file you will use the
Start menu.

Choose Start > Shape > FreeStyle from the menubar to display the New Part dialog box.

Enter the part name in the Enter part name edit box and choose the OK button from the
New Part dialog box; a new file is started in the FreeStyle workbench.

Creating a Planar Surface

The planar surface for this tutorial will be created on the xy plane.

Select the xy plane and then choose the Unified Patch tool from the Patches sub-toolbar
of the Surface Creation toolbar; the Unified Patch dialog box is displayed.

Select the 2-Point Patch button from this dialog box, if it is not selected by default; you are
prompted to specify the start point of the planar surface.

Click in the drawing area to specify the start point of the planar surface and then invoke the
shortcut menu to specity the dimension of the planar surface. Choose the Edit Dimensions
options from the shortcut menu; the Dimensions dialog box is displayed. In the dialog
box, enter the value in L1 and L2 edit boxes as 150. Next, choose the OK button from the
Dimensions dialog box.

Keeping rest of the options as default in the Unified Patch dialog box, choose the OK
button from this dialog box and close it. Figure 18-56 shows the resultant planar surface.

Figure 18-56 A planar surface

Creating a Curve at the Center of the Planar Surface
To create a datum plane on the surface, first you need to create a curve.

1.

Choose the Curve on Surface tool from the Curve Creation toolbar; the Options dialog
box is displayed and you are prompted to select a face.

Select the planar surface; you are prompted to select a point on the face.

Select the Automatic selection option from the drop-down available in the Mode area of
the Option dialog box.
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4. Specity 0 and 1 as value in the U and V spinner respectively and choose OK from this dialog
box. Figure 18-57 displays the curve created on the planer face.

Curve Created

Figure 18-57 The curve created on the planer face

Changing the Number of Control Points

1. Select the planar patch on the surface and then choose the Control Points tool from the
Shape Modification toolbar; the surface is displayed, as shown in Figure 18-58. Also, the
Control Points dialog box is displayed, as shown in Figure 18-59.
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Figure 18-58 The surface afler choosing the Figure 18-59 The Control
Control Points tool Points dialog box

2. Keep on clicking on the horizontal Nv:4 pop-up on the surface until it changes to Nv:11.

3. Similarly, keep on clicking on the vertical Nv:4 pop-up on the surface until it changes to
Nu:11. After changing the values, the surface is displayed, as shown in Figure 18-60.
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Figure 18-60 The surface afler changing the Nu and Nv options

Creating the Datum Plane on the Surface

. C X ) A i
1. Right-click in the selection box of the Symmetry area in the Emm :'C
Control Points dialog box; a shortcut menu is displayed, -
as shown in Figure 18-61. et~
= YZ Plane
2. Choose the Create Plane option from the shortcut menu; =

the Plane Definition dialog box is displayed. Figure 18-61 The shortcut menu

3. Select the Normal to curve option from the Plane type drop-down list in the dialog box;
the Plane Definition dialog box is modified, as shown in Figure 18-62.

4. Select the curve created earlier and choose the OK button; a plane is created, as shown in
Figure 18-63, and the Control Points dialog box is displayed again.

o
Plane type: | Cffset frem plane ~ \M
Offset: |?_Omm EI
Reverse Direction l
Ol
= o Cancel
| | |
Figure 18-62 The Plane Definition Figure 18-63 The plane created

dialog box with the Normal to Curve
option selected
5. Select Top View from the Quick View sub toolbar; the top view of the surface is displayed.

Deforming the Surface
1. Choose the Points only option from the Filters area of the Control Points dialog box to
deform the surface using only points, if it is not chosen by default. Next, select the center
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control point and slightly drag it toward the left, as shown in Figure 18-64. Make sure that
Screen Plane button is selected in the Support area.

Figure 18-64 The surface afier dragging the center control point

2. Select the corner point and drag it inward in the surface; the surface after dragging the
corner point is displayed, as shown in Figure 18-65.

Figure 18-65 The surface after dragging the corner control point

3. Select the Mesh only option from the Filters area of the Control Points dialog box and
deform the surface, as shown in Figure 18-66.
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Figure 18-66 The surface after deformation using the mesh

4. Change the view to Isometric and choose the Normal to compass option from the Support
area of the dialog box.

5. Using the mesh, deform the surface such that the surface is displayed, as shown in
Figure 18-67.

Figure 18-67 The surface after deformation
in vertical direction using the mesh

6. Choose OK from the Control Points dialog box and hide the curve and the datum plane.
The final model of the car bonnet is displayed, as shown in Figure 18-68.
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Figure 18-68 Final model of the Car bonnet

Saving and Closing the File

1. Choose the Save button from the Standard toolbar to save the file.

2. Close the file by choosing File > Close from the menu bar.

Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of this
chapter:

1. Which of the following tools is used to join two or more surfaces?

(a) FreeStyle Blend Surface (b) 3-Point Patch
(c) Extrude Surface (d) Offset Surface

2. Which of the following tools is used to create a surface using the guide and profile curves?

(a) Operations (b) Control Points
(c) Styling Extrapolate (d) Net Surface
3. The tool is used to convert a mono-cell curve into multiple contiguous curves.

4. 'Tools in the FreeStyle workbench can be used in both the Part mode and the Shape mode.
(1/F)

5. The Patch tool is available in the Shape Modification toolbar. (1/F)
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Review Questions

Answer the following questions:
1. Which of the following toolbars contains the Break Surface or Curve tool?

(a) Operations (b) Shape Modification
(c) Surface Creation (d) None of these

2. Which of the following tools is used to modify the shape of a surface by using mesh?

(a) Operations (b) Control Points
(c) Styling Extrapolate (d) Net Surface
3. The tool is used to create a copy of the selected surface or shape symmetric

about a specified reference.

4. The Geometry Extraction tool is used to create a surface by using an existing surface shape.
(T/F)

5. You can select only one surface while creating an offset surface using the Offset Surface
tool. (T/F)

EXERCISE

Exercise 1

Create the surface model, as shown in Figure 18-69. The surface model with control vertices is
displayed in Figure 18-70. For dimensions, refer to Figure 18-71.
(Expected time: 15 min)

Figure 18-69 The surface model of an Ashtray
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Figure 18-70 The surface model with control vertices

500 150

Figure 18-71 The dimensions of the surface model

Answers to Self-Evaluation Test
1. FreeStyle Blend Surface, 2. Net Surface, 3. Fragmentation, 4.1, 5. I



